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Disclaimer

This document and all the information contained within it is proprietary to Armfield
Limited. This document must not be used for any purpose other than that for which it
is supplied and its contents must not be reproduced, modified, adapted, published,
translated or disclosed to any third party, in whole or in part, without the prior written
permission of Armfield Limited.

Should you have any queries or comments, please contact the Armfield Customer
Support helpdesk (Monday to Friday: 0800 — 1800 GMT). Contact details are as
follows:

(0) 1425 478781 g +44 (0) 1425 478781
(calls charged at local rate) § (international rates apply)

Email: support@armfield.co.uk

Fax: +44 (0) 1425 470916

Copyright and Trademarks
Copyright © 2009 Armfield Limited. All rights reserved.

Any technical documentation made available by Armfield Limited is the copyright
work of Armfield Limited and wholly owned by Armfield Limited. !

Brands and product names mentioned in this manual may be trademarks or
registered trademarks of their respective companies and are hereby acknowledged.




General Overview

The Armfield C6-MKII-10 Fluid Friction Apparatus is designed to allow the detailed
study of the fluid friction head losses which occur when an incompressible fluid flows
through pipes, bends, valves and pipe flow metering devices.

Friction head losses in straight pipes of different sizes can be investigated over a
range of Reynolds’ numbers from 10° to nearly 10°, thereby covering the laminar,
transitional and turbulent flow regimes in smooth pipes. A further test pipe is
artificially roughened and, at the higher Reynolds’ numbers, shows a clear departure
from typical smooth bore pipe characteristics.

In addition to the smooth and roughened pipes, a wide range of pipeline components
are fitted, including pipe fittings and control valves, allowing investigation of the
losses caused by this type of connection. A clear acrylic section of pipeline houses a
Venturi meter, an orifice plate assembly and a Pitot tube, so that these can be
investigated as flow measurement devices.

The C6-MKII-10 is designed to be operated in conjunction with the Armfield F1-10
Hydraulics Bench. The unit can be used with a range of instrumentation packages
including water and mercury manometers, hand-held digital pressure meters and a
computer data logging pack.

C6-MKIlI Fluid Friction Apparatus




Figure 1: General Arrangement of C6-MKII-10 Fluid Friction Apparatus

Equipment Diagrams
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Important Safety Information

Introduction

All practical work areas and laboratories should be covered by local safety
regulations which must be followed at all times.

It is the responsibility of the owner to ensure that all users are made aware of
relevant local regulations, and that the apparatus is operated in accordance with
those regulations. If requested then Armfield can supply a typical set of standard
laboratory safety rules, but these are guidelines only and should be modified as
required. Supervision of users should be provided whenever appropriate.

Your C6-MKII-10 Fluid Friction Apparatus has been designed to be safe in use
when installed, operated and maintained in accordance with the instructions in this
manual. As with any piece of sophisticated equipment, dangers exist if the equipment
is misused, mishandled or badly maintained.

Water Borne Hazards

The equipment described in this instruction manual involves the use of water, which
under certain conditions can create a health hazard due to infection by harmful
micro-organisms. ‘

For example, the microscopic bacterium called Legionella pneumophila will feed on
any scale, rust, algae or sludge in water and will breed rapidly if the temperature of
water is between 20 and 45°C. Any water containing this bacterium which is sprayed
or splashed creating air-borne droplets can produce a form of pneumonia called
Legionnaires Disease which is potentially fatal.

Legionella is not the only harmful micro-organism which can-infect water, but it
serves as a useful example of the need for cleanliness.

Under the COSHH regulations, the following precautions must be observed:

o Any water contained within the product must not be allowed to stagnate, ie.
the water must be changed regularly.

o Any rust, sludge, scale or algae on which micro-organisms can feed must be
removed regularly, i.e. the equipment must be cleaned regularly.

o Where practicable the water should be maintained at a temperature below
20°C. If this is not practicable then the water should be disinfected if it is safe
and appropriate to do so. Note that other hazards may exist in the handling of
biocides used to disinfect the water.

« A scheme should be prepared for preventing or controlling the risk
incorporating all of the actions listed above.

Further details on preventing infection are contained in the publication “The Control
of Legionellosis including Legionnaires Disease” - Health and Safety Series booklet
HS (G) 70. :
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Description
Where necessary, refer to the drawings in the Equipment Diagrams section.

Overview

The test pipes and fittings are mounted on a tubular frame carried castors. Water is
fed in from the hydraulics bench via the barbed connector (1), flows through the
network of pipes and fittings, and is fed back into the volumetric tank via the exit tube
(23). The pipes are arranged to provide facilities for testing the following:

¢ Anin-line strainer (2)

o An artificially roughened pipe (7)

«  Smooth bore pipes of 4 different diameters (8), (9), (10) and (11)
¢ Along radius 90° bend (6)

e A short radius 90° bend (15)

o A45°%Y” (4)

e A 45° elbow (5)

e A90°“T"(13)

e A 90° mitre (14)

e A 90° elbow (22)

¢ A sudden contraction (3)

¢ A sudden enlargement (16)

» A pipe section made of clear acrylic with a Pitot static tube (17)
¢ A Venturi made of clear acrylic (18)

e An orifice meter made of clear acrylic (19)

e Aball valve (12)

¢ Aglobe valve (20)

e A gate valve (21)

Short samples of each size test pipe (24) are provided loose so that the students can
measure the exact diameter and determine the nature of the internal finish. The ratio
of the diameter of the pipe to the distance of the pressure tappings from the ends of
each pipe has been selected to minimise end and entry effects.

A system of isolating valves (25) is provided whereby the pipe to be tested can be
selected without disconnecting or draining the system. The arrangement also allows
tests to be conducted on parallel pipe configurations.

Each pressure tapping is fitted with a quick connection facility. Probe attachments
with an adequate quantity of translucent polythene tubing are provided, so that any
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pair of pressure tappings can be rapidly connected to the pressure measurement
system.

C6-50 Data Logging Accessory

The C6-50 Data Logging Accessory consists of a turbine type flow meter, two
pressure sensors with quick release connectors and a signal conditioning and
interface console.

The unit is powered by a separate power supply unit and is connected to the
computer via a USB socket at the rear. Two LEDs on the front panel illuminate when
the unit is powered and active.

The C6-50 is supplied with software on CD-ROM. The following are minimum
computer requirements; - .

e Pentium Processor

e 32MB RAM

e« CD-ROM Drive

¢ 15MB Hard Disk Space

e SVGA Display (800 x 600)
 USB Port

¢ Windows 98, ME, 2000 or XP

The software provides a mimic diagram with sensor readings and calculated
variables superimposed in real time. Results can be stored in a spreadsheet and
displayed in graphical format. The software also includes full help facilities.

Refer to the separate instruction manual supplied with C6-50 for details about
connecting and operating the Data Logging accessory.
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Installation

Advisory

Before operating the equipment, it must be unpacked, assembled and installed as
described in the steps that follow. Safe use of the equipment depends on following
the correct installation procedure.

Installation Process

1. Connect the F1-10 Hydraulics Bench to a suitable electrical supply. The
supply MUST BE EARTHED. Test the RCD before continuing.

, i b) Test the RCD. The davice
a) Fit an appropriate plug to the end of the / A BT 4 o
power cable f necsssary). The sockst you | [ MUST trip when the butlon is

€ p i. i it doss not, consult
connect to must be earthed. a competent electrician.

The glectrical supply must be as follows:

Version | Voitage Cycles | Fuse !
F1-10-A 220 50 3A
F1-10-B 116 50 3A
F1-10-G 220 &80 3A

Consult the F1-10 Product Manual for further
details,

if the equipment is used in an emvironment |
where it may becoms slectrically live, Armfisld %
recommend that the pipework is earthed using
the strap provided.

2. Fill the hydraulics bench sump tank with water.

%

a) Fill the hydraulics banch via the dump
valve in the bottom of the volumetric tank.

The level should be just bensath the dump
valve,

3. Position the pipe network (C6-10) next to the hydraulics bench (F1-10), with
the outlet pipe from the pipe network over the volumetric tank. Ensure that the
stilling baffle is in place in the volumetric tank.
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4. Connect the C6-MKII-10 the F1-10. Use the plastic hose clips provided to
clamp the flexible hose to the inlet to the pipe network.

y - cj Tighten tube
a) Remove the / o clips around hose
yellow HozebLock e to prevent jeakage

fitting from the F1- [/
10 bench and i {
screw on the

#) Fitthe \

fexible hose

adapter supplied. aver the

adapter and

tighten the

hose clip.

S N [ | d}Insert cutlet
) e A . ] tubs inta
J {1 compression
P —. (N fitting and tighten

5 1o snsure no
! ’ ] ieakage
1

©} Hand-fighten
the knurlsd
fastener to
compress the
a-ring and

B prevent leaks /x,%x

b} Insert the Pitot
tube asssmbly
into the boss and
twist until the
stem is vertical

a} Enszure that the
tube s facing the
direction of flow.

e
e
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€
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€
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T
€
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«
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L — d) sonnect the Pitot
i o tube to the quick
release  connectar
using the - flaxible
hose provided.
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6. Switch on the pump and prime the system.

/.(‘:

a} Ensure that the cantrol

f
{
#

valve is fully closed

b} Switch on
the pump

l

) Slowly open the control

d) Open valves one at a

o valve and allow water to
; / circulate
P
I8
ot SE—

time to purge air from
system

Installation




Operation

Where necessary, refer to the drawings in the Equipment Diagrams section.

The apparatus must be set up in accordance with the Installation section.

Operating the Software

Note: The diagrams in this section are included as typical examples and may not
relate specifically to an individual product.

The Armfield Software is a powerful Educational and Data Logging tool with a wide
range of features. Some of the major features are highlighted below, to assist users,
but full details on the software and how to use it are provided in the presentations
and Help text incorperated in the Software. Help on Using the Software or Using the
Equipment is available by clicking the appropriate topic in the Help drop-down menu
from the upper toolbar when operating the software as shown:

 Fls Edi View [ Ssiple Fomst Widow Hel |

: I EI e UaTheSolwme b
= . e Using The Eguipmast &

Aboul

Load the software. If multiple experiments are available then a menu will be

displayed listing the options. Wait for the presentation screen to open fully as shown:

i Equipment

Theory

These presentations can help vou use the Armfield software:
Experiment

ST = How to use the software: Click on ‘NEXT button
Questions
How to set up the equipment: Select ‘Equipment tab

« The theory for the experiment. Select ‘Theory tab

= How to do the experiment: Sefect ‘Experiment tab
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Operation

Presentation Screen - Basics and Navigation

As stated above, the software starts with the Presentation Screen displayed. The
user is met by a simple presentation which gives them an overview of the capabilities
of the equipment and software and explains in simple terms how to navigate around
the software and summarizes the major facilities complete with direct links to detailed
context sensitive ‘help’ texts.

To view the presentations click Next or click the required topic in the left hand pane
as appropriate. Click More while displaying any of the topics to display a Help index
related to that topic.

To return to the Presentation screen at any time click the View Presentation icon

from the main toel bar or click Presentation from the dropdown menu as
shown:

For more detailed information about the presentations refer to the Help available via
the upper toolbar when operating the software.
Toolbar

A toolbar is displayed at the top of the screen at all times, so users can jump
immediately to the facility they require, as shown:

L EERE AK 2 %9 ®

The upper menu expands as-a dropdown menu when the cursor is placed over a
name.

The lower row of icons (standard for all Armfield Software) allows a particular
function to be selected. To aid recognition, pop-up text names appear when the
cursor is placed over the icon.

Mimic Diagram

The Mimic Diagram is the most commonly used screen and gives a pictorial
representation of the equipment, with boxes to enter measurements from the
equipment, display any calculated variables etc. directly in engineering units.

from the main tool bar

To view the Mimic Diagram click the View Diagram icon
or click Diagram from the View drop-down menu as shown:

11
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el m_:e_.mﬁd,a%‘a‘. ‘v ;

The details in the diagram will vary depending on the equipment chosen if multiple
experiments are available. .

Manual data input boxes with a coloured background allow measured variables,
constants such as Orifice Cd and Atmospheric Pressure, as appropriate, to be
changed by over-typing the default value. After typing the value press the Return key
or click on a different box to enter the value.

In addition to measured variables such as Volume, Time, Temperature or Pressure,
calculated data such as Discharge / Volume flowrate, Headloss etc are continuously
displayed in data boxes with a white background. These are automatically updated
and cannot be changed by the user.

After entering a complete set of data from measurements on the equipment click on

the === icon to save the set of results before entering another set.

12
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Operation

The mimic diagram associated with some products includes the facility to select
different experiments or different accessories, usually on the left hand side of the
screen, as shown:

Clicking on the appropriate accessory or exercise will change the associated mimic
diagram, table, graphs etc to suit the exercise being performed.
Data Logging Facilities in the Mimic Diagram

Armfield software designed for manual entry of measured variables does not include
automatic data logging facilities and these options are greyed out where not

appropriate. When manually entering data the icon simply saves the set of

entered data into a spreadsheet as described above.

Tabular Display

To view the Table screen click the View Table icon el from the main tool bar or
click Table from the View dropdown menu as shown:

Tonbsrs

The data is displayed in a tabular format, similar to the screen as shown:

13
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As the data is sampled, it is stored in spreadsheet format, updated each time the
data is sampled. The table also contains columns for the calculated values.

New sheets can be added to the spreadsheet for different data runs by clicking the

icon from the main toolbar. Sheets can be renamed by double clicking on the
sheet name at the bottom left corner of the screen (initially Run 1, Run 2 etc) then
entering the required name.

For more detailed information about Data Logging and changing the settings within
the software refer to the Help available via the upper toolbar when operating the
software.

Graphical Display

When several samples have been recorded, they can be viewed in graphical format.

To view the data in Graphical format click the View graph icon
tool bar or click Graph from the View drop-down menu as shown:

from the main

The results are displayed in a graphical format as shown:

14
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Operation

(The actual graph displayed will depend on the product selected and the exercise
that is being conducted, the data that has been logged and the parameter(s) that has
been selected).

Powerful and flexible graph plotting tools are available in the software, allowing the
user full choice over what is displayed, including dual y axes, points or lines,
displaying data from different runs, etc. Formatting and scaling is done automatically
by default, but can be changed manually if required.

To change the data displayed on the Graph click Graph Data from the Format
dropdown menu as shown:

The available parameters (Series of data) are displayed in the left hand pane as
shown:

15
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Two axes are available for plotting, allowing series with different scaling to be
presented on the same x axis.

To select a series for plotting, click the appropriate series in the left pane so that it is
highlighted then click the appropriate right-facing arrow to move the series into one of
the windows in the right hand pane. Multiple series with the same scaling can be:
plotted simultaneously by moving them all into the same window in the right pane.

To remove a series from the graph, click the appropriate series in the right pane so
that it is highlighted then click the appropriate left-facing arrow to move the series into
the left pane.

The X-Axis Content is chosen by default to suit the exercise. The content can be
changed if appropriate by opening the drop down menu at the top of the window.

The format of the graphs, scaling of the axes etc. can be changed if required by
clicking Graph in the Format drop-down menu as shown:

A Yew Upbons Soagks | B

For more detailed information about changing these settings refer to the Help
available via the upper toolbar when operating the software.

16
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Operation

Operating the Equipment

Controlling the Flow

-Water is pumped through the Fluid Friction Apparatus using a centrifugal pump

mounted on the underside of the hydraulics bench. The pump can be switched on
and off using the Power switch indicated below. The Flow Control Valve should
always be closed before starting the pump.

Peswier swdich

RCD

ight Gauge and Fiow Control  Sump tank
Lavel Seals Walie dran valve

Hydraulics Bench Controls

Water flows through the connector in the channel on the bench top, through the
flexible connecting hose shown below and into the C6-MKII-10. It will then flow

through whichever of the test pipes is selected, back through the acrylic pipe section

and into the volumetric tank in the hydraulics bench.

17
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Inlet and Outlet Pipe Arrangement

Flow rates through the apparatus may be adjusted by operation of the Control Valve
on the hydraulics bench. Simultaneous operation of the flow control valve with the
two outlet valves (gate and globe) shown above, will permit adjustment of the static
pressure in the apparatus together with the flow rate. Using the three valves in
combination it should be possible to achieve fine adjustment of the flow.

The flow path through the pipe friction network is controlled using the system of
isolating valves shown below. By opening and closing these valves as appropriate it
is possible to select flow through any combination of pipes.

Isolating Valves

Volumetric Flow Measurement

The service module incorporates a moulded volumetric measuring tank which is
stepped to accommodate low or high flow rates. A stilling baffle is incorporated to
reduce turbulence.

A remote sight gauge (see below), consisting of a sight tube and scale, is connected
to a tapping in the base of the tank and gives an instantaneous indication of water
level. The scale is divided into two zones corresponding to the volume above and
below the step in the tank.

18
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Operation

Power switch

RCD

Sight Gauge and Flow Control Sump tank
Level Scale ~ Vake drainvalve

Sight Gauge

A dump valve in the base of the volumetric tank is operated by a remote actuator. In
operation, the volumetric tank is emptied by lifting the dump valve, allowing the
entrained water to return to the sump. When test conditions have stabilised, the
dump valve is lowered, retaining the water in the tank.

Timings are taken as the water level rises in the tank. Low flow rates are monitored
on the lower portion of the scale corresponding to the small volume beneath the step.
Larger flow rates are monitored on the upper scale corresponding to the main tank.

Before operation, the position of the scale relative to the tank should be adjusted as
described in the F1-10 instruction manual.

When very small volumetric flow rates are to be measured, the measuring cylinder
supplied with the F1-10 should be used rather than the volumetric tank. When using
the measuring cylinder, diversion of the flow to and from the cylinder should be
synchronised as closely as possible with the starting and stopping of a watch; do not
attempt to use a definite time or a definite volume.

Pressure Measurement

The head loss due to pipe friction is measured by taking pressure readings at
different tapping points on the pipe network. In order to measure the pressure loss
along a pipe, the pressure measurement device is connected to between a pair of
tappings, using the tubing and connectors supplied.

19
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Each pressure point on the apparatus is fitted with a self-sealing tapping point (see
below). To connect a test probe to a pressure point once the pipe is primed, simply
push the tip of the test probe into the pressure point until it latches. To disconnect a
test probe from a pressure point, press the metal clip of the side of the pressure point
to release the test probe. Both test probe and pressure point will seal to prevent loss
of water.

Tapping Points

Operation with Manometers

Connect the flexible tubes supplied to the inlets at the bottom of the manometer and
fit the quick release connectors to the ends of the tubes. Connect the manometer
tubes to the pipe network at two tappings with a high pressure drop (e.g. either side
of a partially closed valve) and start the pump. Water will be forced through the
manometer, expelling the air in the pipes.

When all air bubbles have been expelled, disconnect the manometer from the pipe
network. The quick release fittings will seal keeping the tubes full of water.

The pressurised water manometer incorporates a Schrader valve which is connected
to the top manifold. This permits the levels in the limbs to be adjusted for
measurement of small differential pressures at various static pressures.

The hand pump supplied will be required to effect reduction of levels at high static
pressures. Alternatively a foot pump (not supplied) may be used.

Operation with Hand Held Pressure Meter (e.g. Armfield H12-8)

Fit the quick release fittings supplied with the C6-MKII-10 to the ends of the tubes on
the hand held pressure meter.

It is important to expel any air which may be trapped in the pipes of the pressure
meter before taking readings. Close the globe valve and partly close the gate valve.
Connect the meter tubes to a convenient pair of tappings (e.g. on the uppermost
pipe) and switch on the pump. Carefully undo one of the nuts holding the tubing to
the pressure meter until liquid is expelled from the joint. Bleed the tube to expel any
air. Tighten the nut and repeat for the other tube.

20
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Operation

When taking readings with the hand held pressure meter, it is important that the
meter is zeroed bfore taking a set of results. With the pump still on, close the outlet
valves and then close the control valve to leave the system at a high static pressure.
When the reading on the meter has stabilised, press the zero button to reset the
meter.

Operation with C6-50 Data Logging Accessory

The data logging accessory is supplied complete and ready for use. The console
should be placed in a suitable location where it cannot be splashed by water.
Although it contains no mains voltage components, the case is not watertight. The
console must be powered using the adapter supplied.

Connect the two pressure sensors to the pair of tappings you wish to monitor. The
flow meter measures the flow at the outlet from the C6-MKII-10. - -

When using the computer data logging accessory, it is important to calibrate the
sensors in the software to achieve good accuracy. For the pressure sensors this will
involve comparison with, for example, a suitable hand held meter, while the flow
meter can be calibrated against timed volumetric measurements.

In order to obtain accurate results at very low flowrates and correspondingly small
pressure differences, it may be necessary to use the volumetric flow measurement
available on F1-10 and a pressurised water manometer or hand held pressure meter
to achieve accurate readings. The software offers the choice of automatic data entry
directly from the sensors or manual entry of readings taken from alternative
instrumentation.

Refer to the separate instruction manual sﬁpplied with C6-50 for details about
connecting and operating the Data Logging accessory.

For further assistance on calibrating the software to suit the sensors fitted, refer to

the Help available via the upper toolbar when operating the software or refer to the
separate C6-50 Instruction Manual.

21




Equipment Specifications

Overall Dimensions
Height - 1.10m

Length - 2.65m

Width

- 0.50m

Test Pipe Diameters

1: 19.1mm x 17.2mm

2: 12.7mm x 10.9mm

3: 9.5mm x 7.7rﬁnm

4: 6.4mm x 4.5ﬁ1m

5: 19.1mm x 15.2mm (artificially roughened)

Distance between tappings: 1.00m

Environmental Conditions

This equipment has been designed for operation in the following environmental
conditions. Operation outside of these conditions may result reduced performance,
damage to the equipment or hazard to the operator.

a.

b.

Indoor use;
Altitude up to 2000 m;
Temperature 5 °C to 40 °C;

Maximum relative humidity 80 % for temperatures up to 31 °C, decreasing
linearly to 50 % relative humidity at 40 °C;

Mains supply voltage fluctuations up to +10 % of the nominal voltage;
Transient over-voltages typically present on the MAINS supply;

NOTE: The normal level of transient over-voltages is impulse withstand (over-
voltage) category Il of IEC 60364-4-443,;

Pollution degree 2.
Normally only nonconductive pollution occurs.
Temporary conductivity caused by condensation is to be expected.

Typical of an office or laboratory environment

22
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Routine Maintenance

Responsibility

To preserve the life and efficient operation of the equipment it is important that the
equipment is properly maintained. Regular maintenance of the equipment is the
responsibility of the end user and must be performed by qualified personnel who
understand the operation of the equipment.

General

Water should be drained from all pipes in the network if the equipment will not be
used in the near future. This may be facilitated by removing the sealing plug from the
port below the ball valve (12) at the bottom of the network (take care not to lose the
sealing washer). Place a suitable receptacle below the outlet to collect the water.
Open all valves in the network including the inlet and outlet flow control valves.
Disconnect the flexible inlet hose from the F1-10 Hydraulics Bench, to allow air to
enter at the top, then close ball valve (12) partially (lever at approximately 45°) to
allow water to drain into the receptacle. It may be necessary to open then close the
ball valve several times to extract all of the water. After draining, open the ball valve
(lever horizontal) then replace the sealing plug ensuring that the sealing washer is
fitted.

Any pressure tapping which leaks unduly should be removed from the pipework and
cleaned using compressed air. The most likely cause of leakage is grit between the
seat and the sealing ball. The valves are not designed to seal 100% in normal
operation and a small amount of water may drip from the tapping until the probe is
inserted. :

If any of the brass compression fittings leak, they can be tightened using an
appropriate tool. .

If the apparatus is to be left for prolonged periods, the Pitot tube assembly should be

removed and stored in a safe place. See the Installation section for details on how to
fit and remove the Pitot tube.
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Laboratory Teaching Exercises

Index to Exercises
Exercise A - Fluid Friction in a Smooth Bore Pipe

Exercise B - Head Loss Due to Pipe Fittings

Exercise C - Fluid Friction in a Roughened Pipe

Exercise D - Flow Measurement Using Differential Head
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Exercise A - Fluid Friction in a Smooth Bore Pipe

Objective

To determine the relationship between head loss due to fluid friction and velocity for
flow of water through smooth bore pipes and to confirm the head loss predicted by a
pipe friction equation.

Method

To obtain a series of readings of head loss at different flow rates through the four
smooth bore test pipes.

Theory
Professor Osborne Reynolds demonstrated that two types of flow may exist in a pipe.

1. Laminar flow at low velocities where hocu

! o~ n
2. Turbulent flow at higher velocities where fre<u
Where h is the head loss due to friction and u is the fluid velocity. These two types of
flow are separated by a transition phase where no definite relationship between h
and u exists.

Graphs of h versus u and log h versus log u show these zones.
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Furthermore, for a circular pipe flowing full, the head loss due to friction may be
calculated from the formula:

b= ﬂ‘i ALu*
28d or 2gd

(1M

where L is the length of the pipe between tappings, d is the internal diameter of the
pipe, u is the mean velocity of water through the pipe in m/s, g is the acceleration due
to gravity in m/s? and f is pipe friction coefficient. Note that the American equivalent
of the British term f is A where A = 4f.

The Reynolds’ number, Re, can be found using the following equation:

pud

H 2)

where p is the molecular viscosity (1.15 x 10 Ns/m? at 15°C) and p is the density
(999 kg/m® at 15°C).

Re =

Having established the value of Reynolds’ number for flow in the pipe, the value of f
may be determined using a Moody diagram, a simplified version of which is shown
below.

Friction Factor f

/

Reynolds number Re

Equation (1) can the be used to determine the theoretical head loss.

Equipment Set Up
The equipment should be installed as described in the Installation section.

Additional equipment required: Stop watch, Internal Vernier calliper.

Arrange the valves on the C6-MKII-10 to allow flow through only the test pipe under
observation.

If using the C6-50 Data Logging accessory, ensure that the console is powered and
connected to the PC via the USB connection. Load the C6-304 software and choose
Exercise A.
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Exercise A

Procedure
Prime the pipe network with water. Open and close the appropriate valves to obtain
flow of water through the required test pipe.

Take readings at several different flow rates, altering the flow using the control valve
on the hydraulics bench (ten readings is sufficient to produce a good head-flow
curve).

Measure flow rates using the volumetric tank (if using C6-304 software, flow rate is
measured directly). For small flow rates use the measuring cylinder. Measure head
loss between the tappings using the portable pressure meter or pressurised water
manometer as appropriate.

Obtain readings on all fpur smooth test pipes.
Measure the internal diameter of each test pipe sample using a Vernier calliper.

Processing Results
All readings should be tabulated as follows:

Volume Time Flow Pipe  [Velocity\Reynolds Calculated Measured

rate Diam. ‘No ES:SC' Il:lead
; : A 0Sss
\ T Q d u Re he h
[litres] [Secs] [m%/s] [m] [m/s] [mH,0]  |[m H,0]

From -
Vx10~ 40  pud  yoopy| ALu” (hc-ho)
_— — c-ho
T md H  Dbiagram| 284

| ® @ ® 0 IEPIEOEEEEEEEEEIBYAD VEEEEEEE Y S

Plot a graph of h versus u for each size of pipe. Identify the laminar, transition and
turbulent zones on the graphs.

Confirm that the graph is a straight line for the zone of laminar flow 1 o U

Plot a graph of log h versus log u for each size of pipe. Confirm that the graph is a

- 1
straight line for the zone of turbulent flow 1 U™ Determine the slope of the
straight line to find n.

Estimate the value of Reynolds number (Re = pud/p) at the start and finish of the
transition phase. These two values of Re are called the upper and lower critical
velocities. ’

Compare the values of head loss determined by calculation with those measured
using the manometer. '
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Confirm that the head loss can be predicted using the pipe friction equation provided
the velocity of the fluid and the pipe dimensions are known.

It is assumed that the molecular viscosity pis 1.15 x 10 Ns/m? at 15°C and the
density p is 999 kg/m? at 15°C.

28
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Exercise B - Head Loss Due to Pipe Fittings

Objective

To determine the head loss associated with flow of water through standard fittings
used in plumbing installations.

Method
Measure the differential head between tappings on fittings and test valves.
Theory
Head loss in a pipe fitting is proportional to the velocity head of the fluid flowing
through the fitting:

- Ku?

h= ‘)_-

“8 (™)

where Kis the fitting ‘loss factor’, u is the mean velocity of water through the pipe in
m/s and g is the acceleration due to gravity in m/s2.

Note: A flow control valve is a pipe fitting which has an adjustable ‘K’ factor. The
minimum value of ‘K’ and the relationship between stem movement and ‘K’ factor are
important in selecting a valve for an application.

Equipment Setup
Additional equipment required: Stop watch.

The following fittings and valves are available for test (numbers in brackets refer to
Figure 1 in the Equipment Diagrams):

Sudden Contraction (3)
Sudden Enlargement (16)
Ball Valve (12)

45° Elbow (22)

45° Mitre (5)

45° Y Junction (4)

Gate Valve (21)

Globe Valve (20)

In Line Strainer (2)

90° Elbow (22)

90° Short Radiﬁs Bend (15)
90° Long Radius Bend (6)
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90° T Junction (13)

If using the C6-50 Data Logging accessory, ensure that the console is powered and

connected to the PC via the USB connection. Load the C6-304 software and choose
Exercise B.

Taking a Set of Results

Prime the network with water. Open and close the appropriate valves to obtain flow

of water through the required fitting.

Take readings at several different flow rates, altering the flow using the control valve
on the hydraulics bench.

Measure flow rates uging the volumetric tank (if using the C6-304 software, flow rate
id measured directly).

Measure differential head between tappings on each fitting using the hand held
pressure meter, sensors or pressurised water manometer.

Processing Results
All readings should be tabulated as follows:

Volume [Time Flow rate |Pipe Velocity |Velocity Measured Fitting {Valve
. Head s
Dia Head Loss Factor |Position
\Y T Q d u hv h K (valves
H 3
[litres] [secs] [[m?3s] [m] [m/s] [mH20] [mH,0] only)
Vx10° 40 | u” h
EE— —7 |=— |(hc-ho) | —
T mrd 2 g f1v

Confirm that K is a constant for each fitting over the range of test flow rates.

Plot a graph of K factor against valve opening for each test valve. Note the
differences in characteristic.
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Exercise C - Fluid Friction in a Roughened Pipe

Objective

To determine the relationship between fluid friction coefficient and Reynolds’ number
for flow of water through a pipe having a roughened bore.

Method

To obtain a series of readings of head loss at different flow rates through the
roughened test pipes.

Theory

The head loss due to friction in a pipe is given by:

-

_AfLu 2 ALu?
2gd

h

or "’é"d

(1)

where L is the length of the pipe between tappings, d is the internal diameter of the
pipe, u is the mean velocity of water through the pipe in m/s, g is the acceleration due
to gravity in m/s? and f is pipe friction coefficient. Note that the American equivalent of
the British term f is A where A = 4f.

The Reynolds’ number, Re, can be found using the following equation:
_ pud
H )

where 1 is the molecular viscosity (1.15 x 10 Ns/m? at 15°C) and p is the density
(999 kg/m? at 15°C).

Re

Having established the value of Reynolds’ number for flow in the pipe, the value of f
may be determined using a Moody diagram, a simplified version of which is shown
below.

Friction Factor f
o
(.f

Reynaolds number Re
Use equation (1) to determine the theoretical head loss.

Equipment Set Up
Additional equipment required: Stop watch, Internal Vernier calliper.
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Open and close the ball valves as required to obtain flow through only the roughened
pipe.

If using the C6-50 Data Logging accessory, ensure that the console is powered and

connected to the PC via the USB connection. Load the C6-304 software and choose
Exercise C.

Taking a Set of Results

Prime the pipe network with water. Open and close the appropriate valves to obtain

flow of water through the roughened pipe.

Take readings at several different flow rates, altering the flow using the control valve
on the hydraulics bench.

Measure flow rates using the volumetric tank (if using the C6-304 software, flow rate
is measured directly). For small flow rates use the measuring cylinder.

Measure head loss between the tappings using the hand-held meter, sensors or
manometer as appropriate.

Estimate the nominal internal diameter of the test pipe sample using a Vernier
calliper (not supplied). Estimate the roughness factor k/d.

Processing Results
All readings should be tabulated as follows:

Volume Time Flow rate Pipe Velocity Reynolds e ti Friction
Diam. Number ::l ead Coefficient
oss
\Y T Q d u Re h f
i 3
[litres] [secs] [m3/s] [m] [m/s] [m H,0]
Vx10™ 40 | pud gdh
3 ) (hc - hp) . 5
T el - H 2u”

Pipe length / = m
Roughness height k = m
Plot a graph of pipe friction coefficient versus Reynolds’ number (log scale).

Note the difference from the smooth pipe curve on the Moody diagram when the flow
is turbulent.

32

&:0:EEEE EEEEEE R DR R EEEEEEEE RN

«
[ =
=
©
L=



Exercise D - Flow Measurement Using Differential Head

Objective

To demonstrate the application of differential head devices in the measurement of
flow rate and velocity of water in a pipe.

Method

To obtain a series of readings of head loss at different flow rates through an orifice
plate, a Venturi meter and a Pitot tube.

Theory

For an orifice plate or Venturi, the flow rate and differential head are related by
Bernoulli’s equation with a discharge coefficient added to account for losses:

Q=Cd- A, ;_ 28°Ch
Vi4,/4,) -1 0

where Q is the flow rate in m®/s, Cd is the discharge coefficient (Cd = 0.98 for a
Venturi, 0.62 for an orifice plate), A, is the area of the throat or orifice in m? (do =
14mm for the Venturi, 20mm for the orifice plate), A4 is the area of the pipe upstream

m? (d4 = 24mm), &h s the differential head in metres of water and g is the
acceleration due to gravity in m/s2.

For a Pitot tube, the differential head measured between the total and static tappings
is equivalent to the velocity head of the fluid:

Q; = (b — 1)
70

Fosd
T,

(2)

y Q{II ,) o

where u is the mean velocity of water through the pipe in m/s, hy - h; is the
differential head in metres of water and g is the acceleration due to gravity in m/s2.

Equipment Set Up

Additional equipment required: Stop watch, Internal Vernier calliper.

Open all ball valves to achieve the minimum restriction to flow.

If using the C6-50 Data Logging accessory, ensure that the console is powered and

connected to the PC via the USB connection. Load the C6-304 software and choose
Exercise D.

Taking a Set of Results (using the Venturi and orifice plate)

Prime the pipe network with water. Open the appropriate valves to obtain flow of
water through the flowmeters.
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Obtain readings from the Venturi and orifice plate at different flow rates from
minimum to maximum flow, altering the flow rate using the control valve on the
hydraulics bench. At each setting measure the differential head produced by each
flowmeter, the head loss across each flowmeter and the corresponding volume
flowrate.

Note: To measure the differential head developed by the orifice plate or Venturi (for
the purpose of flow measurement) connect the probes from the appropriate
manometer to the two tappings on the flowmeter body, upstream and at the throat
(do not use the downstream tapping in the pipe). To measure the head loss across
the orifice plate or Venturi connect the probes from the water manometer to the
upstream tapping on the flowmeter body and the tapping in the pipe downstream of
the device (do not use the throat tapping).

Processing Results’(for the Venturi and orifice plate)
All readings should be tabulated as follows:

\VVolume Time Flow rate Differential Flowrate Head Loss
calculated
Head

\ T Qm h Qc hl
[litres] [secs] [m?¥/s] [m H20] [m¥s] [m H,0]

Vx10™

—_— Egn (1) (ha-hs)

T

Compare each calculated flowrate with the actual flowrate measured.
Compare the head loss across the Venturi and orifice at the same flowrate.

Compare the differential head across the Venturi and orifice plate at the same
flowrate.

Comment on the differences in the two devices and their suitability for flow
measurement.

Use the theory covered by Experiment C to determine the K factor for the two
flowmeters.

Taking a Set of Results (for the Pitot tube)

Ensure that the nose of the Pitot tube is directly facing the direction of flow and
located on the centre line of the pipe.

Obtain readings from the Pitot tube at different flowrates from minimum to maximum
flow. At each setting of the flow control valve measure the differential head produced
by the Pitot tube and the corresponding volume flowrate.

At the maximum flow setting unscrew the sealing gland sufficiently to allow the Pitot
tube to move. Traverse the tube across the diameter of the pipe and observe the

34

e,

L

R ﬂ

(
j

PERPOEERERRERARERERRERAEAEODOEREERERRERAEORARARA S




B oo BBEBEEEREIEDDDEOEEGOEE08008889 66

T

Exercise D

change in differential head. Estimate the average reading obtained and compare this
with the maximum reading at the centre of the pipe.

Processing Results (for the Pitot tube)
All readings should be tabulated as follows:

Pitot |Volume[Time |Flowrate [Pipe Pipe |Velocity |DifferentiallVelocity
Tube diameter|Area |measured|Head calculated
Position|V T Q d A Um h Uc
[litres] |[secs] [[m®/s] [m] [m?]  |[m/s] [m HxQO] [[m/s]
————? X107 7d” g (hc-ho)  [(2gh)°®
T 4 |A

Compare each calculated velocity with the measured velocity (determined from the

volume flowrate and cross sectional area of the pipe).

What is the effect of the velocity profile on the results obtained?

Note: The Pitot tube is included for the purpose of demonstration only. The small
differential head produced by the Pitot tube means that it should only be used in
applications where high velocity is to be measured. Accuracy of measurement on the
C6-MKII-10 will be poor because of the low water velocity.
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Contact Details for Further Information

Main Office:

US Office:

Armfield Limited

Bridge House
West Street
Ringwood
Hampshire
England BH24 1DY

Tel: +44 (0)1425 478781

Fax: +44 (0)1425 470916

Email: sales@armfield.co.uk
support@armfield.co.uk

Web: http://www.armfield.co.uk

Armfield Inc.

436 West Commodore Blvd (#2)
Jackson, NJ 08527

Tel: (732) 928 3332
Fax: (732) 928 3542
Email: info@armfieldinc.com

36

\

e AR RARRRRRRRRRER AR RO R R AR AR RS,




